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Adviser and Manager are whole farm planning, 

paddock based recording, reporting and mapping 

software programs. Both programs can assess 

profitability and risk as you plan and come with a 

comprehensive list of crop, variety and chemical 

inputs, and all can be easily added or edited. 

 

Plans can be viewed as maps with links to soil 

samples. The farms physical resources such as soil 

types, tree plantings and contours can also be 

displayed on a map.  A farm rotation analyser and 

a crop water use calculator are added features. 

 

Adviser and Manager programs are powerful, 

accurate, easy to use and compliant with most 

management systems including yield and paddock 

maps from farm machinery. 
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About Adviser / Manager 

BACKGROUND TO THE SOFTWARE 
Adviser was originally developed to provide Agronomists with a means to quickly provide their 
clients with detailed paddock-based agronomic plans for the coming season while allowing the 
flexibility to modify the plan as the season progressed. 

Those who previously had systems based around combinations of word processors, spreadsheets 

and databases found Adviser to be a single comprehensive solution that reduced preparation time 

substantially and provided a more integrated and professional looking product. 

The software has continued to evolve and expand to suit the requirements of farmers as well as 

Advisers while maintaining ease of use and the original core aims of the software: 

Á To provide fast and efficient agronomic planning 

Á Reduce repetition and save time 

Á Utilise data to provide useful information to help with decision making and communication 

 

Adviser software is to be used as an integral piece of farm machinery throughout the entire farming 
year. We believe it can add much value to a farm business by improved planning, communication 
and informed decision making 

 

ADVISER EDITIONS 
The Adviser family of software is available in several flavours to suit different user requirements and 

budgets. 

ü Adviser is aimed at Consultants, Advisers, Agronomists or anyone who needs to use the 

software for Multiple Clients. 

ü Manager is aimed at farmers or those who wish to use the software for a single farm 

business entity.  Manager does not include all the functions of Adviser 

Both of these versions are ŀǾŀƛƭŀōƭŜ ƛƴ άLiteέ ǾŜǊǎƛƻƴǎ that do not include GIS Mapping and a number 
of other features. 
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USING THIS GUIDE 
Throughout this guide the following symbols are used to help you better understand the software. 

These are: 

: 
Exercises 

These are άƘŀƴŘǎ-ƻƴέ ǇǊŀŎǘƛŎŜ Ǌǳƴǎ that will guide you 
through all the steps to complete a key task 

F Pointers 
Useful tips to help you avoid some of the pitfalls of 
new users 

 Table Layout 
An explanation of the data fields that you will 
encounter in the data entry tables as you use the 
software 

 

!ƴƻǘƘŜǊ ŎƻƴǾŜƴǘƛƻƴ ǘƘŀǘ ȅƻǳ ǿƛƭƭ ŜƴŎƻǳƴǘŜǊ ƛǎ ǘƘŜ άaŜƴǳ tŀǘƘέ These are used to indicate which 

menu commands you use to achieve a specific function. For example, to close the program you 

select the File menu and then the Exit menu contained in the File menu. The menu Path form of this 

is [File/Exit]. A more advanced example could be [Mapping/Layer Library/Saved Layers/Retrieve]. 

Simply start at the main application Menu and work your way through. 

Similarly Keyboard Shortcuts are denoted by [7 ÆA] 

The Guide has been structured to take you through each section of the software in a logical manner 

to get you up and running as quickly as possible. The Guide has been designed to be flexible for use 

as either a self-paced tutorial, training course notes and as a reference source as required. 
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Chapter 1 ς Getting started 
In this chapter you will familiarise yourself with licencing the software, requesting support, the 
software user interface and the process of getting ready to set-up your first Client File. 

1.1 LICENCING 

Licence Manager 
 

The licence manager is accessed through the Help section via the command [Help > Licence 
Manager]. This will then bring up the licence manager window where information on advisor 
licences can be obtained. There are four sections in the licence manger that consist of the licence 
current status, licence product comparison, licence agreements and licence requests. 

Licence Current Status 

This window displays the status information on the licence currently used by the computer. The 
status of the licence is then displayed in the right hand section along with the expiry date, last 
accessed date, issue date, current time and product configuration. 

Product Comparison 

The product comparison section shows a table with all products offered by Back Paddock Company. 
In the neighbouring columns are the products description and its limitations. This section is 
important in determining what product would best be suited for your particular needs.  

Licence Agreement 

This particular section of the report displays the licence agreement for the software 

issued. It is important that this is read and understood before purchasing and using the 

software.  

Licence Request 

The licence request section has three aspects to it, which consist of the user details, privacy 

statement and request licence.  

1. The user details section determines which product you wish to request and also the name and 

location for the software. Choose a particular product and then enter in the details below.  

2. The privacy statement then explains that all the information provided to Back Paddock Company 

is kept confidential.  

3. The request section then displays the particular product and issue length at the top of the 

window. If the information is correct then simply click on the send email request to obtain the above 
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product. To save the request form for another time, simply click on the save request file and it will 

be saved in a particular location for future reference. 

1.2 SUPPORT 
 

The help section at the top of the page can be used to describe certain aspects about the program, 

access the Back Paddock Company ǿŜōǎƛǘŜΣ ŘƛǎǇƭŀȅ ƭƛŎŜƴŎŜ ƳŀƴŀƎŜǊΣ ŎƘŜŎƪ ŦƻǊ ǳǇŘŀǘŜǎ ŀƴŘ άhǇŜƴέ 

the support page. 

If any problems are encountered whilst using this program there are a number of options that can 

be used to overcome the problem or situation. The first step would be to find the particular section 

in this users guide and follow the steps and procedures as followed. If the problem persists or is not 

found within the report then other options can consist of:  

1. Contact Free call help desk on 1800 557166 during 7am-7pm EST 

*If issues with the software, users must be on the latest version so under help check for updates 

when on line before contacting the help desk as often an enhancement in the latest version 

may satisfy your enquiry.  

2. Group Training ς Back Paddock Adviser/Manager training is available in group sessions with a 

minimum number of 10 required. Manager and Manager Lite training can attract government 

subsidies such as FarmBis. All training delivered by Certificate IV, Training and assessment 

accredited trainers.  

3. Master Data Base - an up to date Master Data base can be emailed to users upon request and 

includes the most of the current seed varieties, fertilisers, operations, timings and chemicals 

that could be used on farms in Australia. Default costs and application rates are also included. 

4. Demonstration CD copies - available free upon request, email a request to 

support@backpaddock.com.au, or phone 1800 557 166. The demonstration CD allows users to 

adjust details in two paddocks of a sample farm file. Also included is a video explaining the 

features of Back Paddock Adviser/Manager, a tutorial and a testimonial by an experienced user.  

5. Customised reports - detailed customised reports can be created on a fee for service basis. 
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Chapter 2 ς Setting Up the Farm 
In this Chapter you will learn how to set up the Client File with farms and their associated 
paddocks. This will form the backbone of all future work done on this file and the 
presentation of summaries and Reports. 
 

FILE MANAGEMENT 
 

The native document type for Adviser is the "ADV" file. This file can contain data for any number of 
farms, paddocks and management zones for any number of years. 
 
It is usual for one client file to contain the data of one farm business entity. 
 
To create your initial Client File, complete Exercise 1. After this exercise you will be ready to start 
adding farms and paddocks, which is covered in the next chapter. 
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: 

Exercise 1 
Create a new Client File  
 

¶ Select New From the File menu (or the New 

button  on the Toolbar)  
¶ Check that the path to the correct Drive and 

Folder is correct so you will place it where 
you want it and you can find it later. 

The recommended and default location for client 
files is in; 

My Documents/Back 
Paddock/Software/Adviser/Clients  

This Folder is created during installation and is 
default location when you create a new file. 

¶ Enter a name for the file 

F Naming Client files by the farm business name is 
the preferred practice. This name can be used 
later in report headers. 

 
F A filename can contain up to 255 characters, 

including spaces. But, it cannot contain any of 
the following characters: 

\   / :   *   ?  "  <  > 

 

F It is essential that the file has the άΦŀŘǾέ 
extension. It is possible to accidentally change 
the file name extension when renaming files. 

 

¶ Select Save to create new file  
 

Your newly created file will now be open ready to 
start entering data. 

If it is necessary to change a file name, this can be 
ŘƻƴŜ ƛƴ ǘƘŜ άhǇŜƴέ CƛƭŜ .ƻȄ (select client file and 
click right mouse button), or alternatively in 
Windows Explorer.   

 

 
 
 
 
 

 

CLIENT DETAILS 
Each Client File can contain client information to be 

used when printing reports or as a general 

reference. 

To view or edit Client details go to menu [File > 

Client OptionsϐΦ ¢Ƙƛǎ ǿƛƭƭ άhǇŜƴέ ǘƘŜ /ƭƛŜƴǘ hǇǘƛƻƴǎ 

dialog. Select the Client Details tab and edit fields 

as required. 

BACKING-UP & SAVING DATA 

Before we move on we will cover the very 

important topic of making sure you do not lose 

your data once you have invested the time in 

entering it. 

HOW DOES ADVISER SAVE 
DATA? 
While you are entering data the software 

constantly writes changes to your client file after 

updating each entry. 

You can easily tell when this occurs as when you 

start to edit the symbol at the left of the table row 

you are editing changes to a . After editing is 

complete and the data is saved to disk the symbol 

changes to a . There is no need to manually save, 

as this is automatic each time you update. If the 

program crashes or the computer is closed the 

data will remain intact provided the storage disk is 

operational. To protect against a loss of storage 
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F 
Pointers for Backing-Up Data 

 

Á Get in the habit of backing-up client files after 

each time you make significant changes 

Á If you lose the client file you will have to start 

again from scratch. The file is an investment of 

your time. You can never have too many 

backups. 

Á We have heard from many devastated users 

who did not back-up their file. Some examples 

are; 

o Laptop stolen from car 

o Hard disk failure 

o Accidentally overwrote or deleted file 

o Electrical storm fried PC 

Á A backup saved in a different location would 

have prevented loss in all these cases 

device you must make a back-up copy to a different storage device. 

 
 

BACKING-UP CLIENT FILES 
To back-up your client file the easiest method 

ƛǎ ǘƻ ǳǎŜ ǘƘŜ 9ȄǇƻǊǘκ.ŀŎƪǳǇ /ƭƛŜƴǘ CƛƭŜ !ǎΧ 

Menu command located on the File Menu 

ώCƛƭŜҔ 9ȄǇƻǊǘҔ .ŀŎƪǳǇ /ƭƛŜƴǘ CƛƭŜ !ǎΧϐ. 

¢Ƙƛǎ ŦǳƴŎǘƛƻƴ άhǇŜƴǎέ ŀ ǎǘŀƴŘŀǊŘ ²ƛƴŘƻǿǎ 

save dialog where you can direct it to a new 

location. If desired you can also rename the 

file at this time. 

Examples of where to back-up are: 

¶ USB Thumb drive 

¶ Burn to CD 

¶ A networked hard  

drive on a different  

PC 

You can back-up the file anywhere data can 

be stored. 

Alternatively you can back up files manually 

using Windows Explorer. 

{!±9 /[L9b¢ CL[9 !{Χ MENU COMMAND 

This command is only used when you wish to save the Client file as a different name and make the 

new name the active file. The existing file remains unchanged after this point. This is useful for doing 

ά²Ƙŀǘ ƛŦέ ǎŎŜƴŀǊƛos, though much care should be taken to ensure data remains complete in the 

desired file.  

It is not recommended that this function be used to back-up data. 
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The initial step in creating a new client file is to set up the client details. To do this, go to [File>Client 

Options]. This will bring up an additional window that will enable you to enter all the relevant details 

for the particular client file. 

 

The next step in configuring a new Client File is to set up the farm. Once farms and paddocks are 

added the program is ready to go. 

Click on the Farm Tab at the top of the page to proceed in setting up your farm. 

 

MULTI-FARM 
.ȅ ŘŜŦŀǳƭǘ ƻƴŜ ŦŀǊƳ ŎŀƭƭŜŘ άIƻƳŜ CŀǊƳέ ƛǎ ŎǊŜŀǘŜŘ ŀǘ the time of file creation. If there is only one 

farm for the client file then you may wish to change the name of the farm. This is done in the Multi-

Farm section. Press the  button to view this. 

The Multi-Farm dialog provides the following functions: 

Add a New Farm 

1) To add a new farm, press the Add button.  

2) Name the new farm and any other details in the table.  

3) Close the Multi-Farm dialog when complete. 
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Changing farm sort order 

You can change the order of farms by selecting the row containing the farm you wish to move and 

then pressing either of up or down buttons in the toolbar.  

This order is used for all navigation and presentation throughout the program. 

Deleting Farms 

To delete a farm, select the row of the farm you wish to delete and press the Delete button.  

× NOTE THAT DELETING A FARM WILL PERMANENTLY DELETE ALL DATA FOR THAT FARM 

INCLUDING ALL PADDOCKS, ALL INPUTS FOR ALL YEARS. USE WITH CAUTION!! 

Report Images 

In the Report Images dialog you can add graphics files to be included in the report. These could be: a 

diagram, photo or map or any bitmap or jpeg file. These will appear in reports before the farm they 

are linked to. Take care to not use images that are too large and can fit within A4 page margins. 

 

 

 

Multi -Farm Data Details 

 

 

 

 

SETTING-UP PADDOCKS 
The paddock table on the Farm page allows you to allocate any number of paddocks to a particular 

farm. The table can only include the paddocks from the currently selected farm. 

This is set by using the drop list on the toolbar. If there is only one farm in the Client file then there is 

no need to set the current farm. 

 

 

F 
The Restructure Paddocks section allows you 
to change farm structure without data loss. 
This is covered later. 

 

 

 Table Layout ς Farm Table (Multi-Farm Box) 
 

Exclude  Excludes selected paddock from Navigation, summaries and reports 

Farm Name  Name of farm to be presented throughout all displays 

Rainfall O Average annual rainfall for farm  

LocationID O Unique farm ID for use in Adviser Analyser software 

Notes  Any permanent details for the farm 
O = optional 
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F When initially setting up the farm you may wish to use the 

Quick Entry feature, which can be seen below. 
 

 

 

 

 

Adding Paddocks 

Having selected the current farm (if more than one farm) you can begin to add paddocks. To do this, 

select the Add button on the toolbar.  

The cursor will be ready in the Paddock Name cell so you can begin typing the name immediately. 

Hit the Enter key Ì and the cursor will move to the Area cell where you can type the paddock area 

immediately.  

Quick Entry 

The Quick Entry feature  allows you to automatically add a new paddock after editing the 

area cell and pressing the Enter > Return key Ì on the keyboard. This can make it easy to work 

through a list of paddock names and areas using minimal keystrokes.  

Be careful when on the last paddock not to add an extra paddock. If you do, then simply delete the 

surplus paddock. 

Insert Paddock 

The Add button always adds a paddock to the bottom of the list. Alternatively you can insert a 

paddock by selecting the paddock that you wish a new paddock to appear above and then selecting 

the Insert button  instead of the Add button. A new paddock appears above your current 

selection. 

Deleting a Paddock 

To delete a paddock, select the row of the paddock you wish to delete and press the Delete button. 

 

NOTE THAT DELETING A PADDOCK WILL PERMANENTLY DELETE ALL DATA FOR THAT PADDOCK 

INCLUDING ALL INPUTS FOR ALL YEARS. USE WITH CAUTION 

Sorting Paddock Order 

You can change the order of paddocks by selecting the row containing the paddock you wish to 

move and then pressing either of up or down buttons in the toolbar, to move the paddock in that 

direction.  This order is used for all navigation and presentation throughout the program. 
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 Table Layout ς Paddock Table (Farm Tab) 

 

Exclude  Excludes selected paddock from Navigation, summaries and reports 

Paddock Name  Name of paddock to be presented throughout all displays 

Area  Area in Ha to be used as default throughout 

Soil Details O Description of soil type for paddock 

Boundary (not included in Lite versions) tǊŜǎǎ ǘƻ άhǇŜƴέ ǇŀŘŘƻŎƪ ōƻǳƴŘŀǊȅ ŜŘƛǘƻǊ ƛƴ ƳŀǇǇƛƴƎ 

Arable (not included in Lite versions) tǊŜǎǎ ǘƻ άhǇŜƴέ ǇŀŘŘƻŎƪ ŀǊŀōƭŜ ŀǊŜŀ ŜŘƛǘƻǊ ƛƴ ƳŀǇǇƛƴƎ 

Rain Site O Rainfall collection site relevant to this paddock 

Notes O Any permanent details for the paddock 

   O = optional  

FPointers for setting-up the farm 

 
Á Start by re-naming the Home Farm and adding any additional farms in the Multi-Farm 

section 

Á Add paddocks to each farm in the order you wish them to be presented throughout 

the program 

o Enter paddock area as you go as this is important later when you start 

entering data 

Á .Ŝ ŎŀǊŜŦǳƭ ƴƻǘ ǘƻ ƛƴŎƭǳŘŜ ŀƴȅ ǘȅǇƻΩǎ ǎǳŎƘ ŀǎ ŜȄǘǊŀ ǎǇŀŎŜǎ ƛƴ ƴŀƳŜǎ ŀǎ ǘƘŜǎŜ ǿƛƭƭ ōŜ 

used throughout the entire package 

Á Take care not to add additional paddocks (particularly when using Quick Entry mode) 

or farms that are not required as this can cause problems later on 

 

 

 

PADDOCK TABLE DATA DETAILS 
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: 

Exercise 2 
Adding Farms and Paddocks  
 

 

1. ¦ǎŜ ǘƘŜ /ƭƛŜƴǘ ŦƛƭŜ ȅƻǳ ŎǊŜŀǘŜŘ ƛƴ 9ȄŜǊŎƛǎŜ мΦ LŦ ǘƘƛǎ ƛǎ ƴƻǘ ŀƭǊŜŀŘȅ άhǇŜƴέ ǘƘŜƴ 

άhǇŜƴέ ƛǘ ƴƻǿΦ ¢ƻ άhǇŜƴέ ǳǎŜ ŜƛǘƘŜǊ ǘƘŜ aŜƴǳ ώCƛƭŜκέhǇŜƴέϐ ƻǊ ǘƘŜ άhǇŜƴέ /ƭƛŜƴǘ 

button on the toolbar.   

2. Select the Farm Tab on the Main Screen 

3. Select the Multi-Farm button on the Toolbar 

4. tƭŀŎŜ ǘƘŜ ŎǳǊǎƻǊ ƛƴ ǘƘŜ CŀǊƳ bŀƳŜ ŎŜƭƭ ŀƴŘ ǊŜƴŀƳŜ άIƻƳŜ CŀǊƳέ ǘƻ ǎƻƳŜǘƘƛƴƎ ŜƭǎŜ 

5. Select Add new farm 

6. Type a new farm name for the second farm. The cursor will be ready to overwrite 

ǘƘŜ ŘŜŦŀǳƭǘ άbŜǿ CŀǊƳ нέ ƴŀƳŜΦ 

7. Select the second farm and change the sort order up and down. 

8. Close the Farms Dialog 

9. Select a farm that you wish to add paddocks to using the drop list on the Farm View 

toolbar 

10. SeleŎǘ ǘƘŜ !ŘŘ ōǳǘǘƻƴ ŀƴŘ ǘƘŜƴ ǘȅǇŜ ŀ ƴŜǿ ǇŀŘŘƻŎƪ ƴŀƳŜ ƻǾŜǊ ǘƘŜ ŘŜŦŀǳƭǘ άǇŀŘŘƻŎƪ 

мέ 

11. Hit Enter Ì on the keyboard and then type the area of the paddock 

12. Press Quick Entry on the toolbar once to set Quick-Entry mode 

13. Add a new paddock as before 

14. Type the name and press enter Ì 

15. Type the area and press enter Ì - A new paddock should have been added 

16. Repeat steps 14 and 15 until all desired paddocks are complete 
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Chapter 3 ς Navigation 
In this Chapter you will get an initial feel for how the client file is structured for data 
associated with paddock operations. The concept of the Management Zone is to see how we 
input data and navigate to view the data we want to see. 
 

THE MANAGEMENT VIEW ς WHERE IT ALL HAPPENS 
Most data entry in Adviser is performed in the Management View. This view is activated by selecting 

the Management Tab on the main Client screen. 

 

The Management View is dived into a number of Panes. With the exception of the Navigation Pane, 

all panes are used to enter or view data. 

MANAGEMENT ZONES  
¢ƘŜ ǘŜǊƳ άaŀnagement ½ƻƴŜέ ƛǎ ǳǎŜŘ ƛƴ !ŘǾƛǎŜǊ ǘƻ ǊŜŦŜǊ ǘƻ ŀ ǇŀǊǘƛŎǳƭŀǊ ǇƛŜŎŜ ƻŦ ƭŀƴŘ ƻǾŜǊ ŀ ƎƛǾŜƴ 

timeframe. This is generally a paddock in a given year, though can be a part of a paddock in the case 

of split paddocks. Later you will see that inputs are allocated to Management Zones. This section will 

cover the methods of moving between Management Zones to select the sections related to them 

and allow you to view, add or edit data for a particular zone. 
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NAVIGATION PANE  
To move between paddocks you must use the Navigation Pane. 

Summary and Rotation scope can also be set using the Navigation Pane to select different levels 

such as All Farms, Selected Farm, Selected Paddock or Selected Usage. 

The Navigation Pane has several modes of presentation. These are: 

 

¶  Normal Mode - Tree shows hierarchy of Farms and 

Paddocks. See example to the left. 

 

 

 

 

 

 

 

 

 

 

 

 

 

¶ Crop Mode - Tree shows hierarchy of Crop type 

and Paddocks. See example to the right. 
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¶ Link Mode - Tree shows paddocks / master paddocks 

as parent nodes of any paddocks or management 

zones that are linked to them using paddock linking. 

See example to the left. 

 

 

 

 

 

 

 

 

 

 

 

¶ Map Mode - (not included in Lite versions) Paddock 

map allows navigation by paddock boundary selection 

or keyboard arrows. Use mouse wheel to zoom. See 

example to the right. 
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F The Farm Year can also be set using keyboard 
shortcuts. 
[7 Æ+] to move to the next year 
[7 Æ-] to move to the previous year. 

 

 

 

PADDOCK SELECTION 
In the non-map modes where a hierarchical tree is used, navigate by initially selecting a paddock 

from the tree. Selection of paddocks can then be by: 

¶ Selecting another paddock using the mouse 

¶ Using the up or down arrows on the keyboard 

¶ Typing the first letter of a paddock to move to (can be repeated until correct paddock is 

selected) 

THE FARM YEAR 
Data input and summary is considered in 

terms of a Farm Year. The Farm Year is set 

in the toolbar of the Management Zone 

Pane. To change year select the left or 

right buttons to move to the previous or 

next year respectively. By default the 

program opens in the current year. 

The Farm Year is not necessarily a calendar year. The starting month may be important for dates in 

the Cash flow or Diary sections. 

The starting month of the Farm Year can be set by selecting menu [File>Client Options] and 

choosing a month in the drop down list. 

PLAN & ACTUALS MODE 
While navigating, it is also important to be aware of the Plan status. By default a Client File opens in 

Plan mode. Plan mode is for looking forward to costs and actions that have not yet occurred. 

Throughout the year actuals can be added with the real situation without overwriting the plan. 

To switch between Plan and Actual mode press the button on the Main Toolbar. You can also use the 

menu command [View>Actuals]. 

 

 

 
 
 
 
 
 

F You can also toggle between Plan and Actual 
mode by using the keyboard shortcut  
[7 ÆA] 
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Chapter 4 ς The Master Database 
In this Chapter you will find out about one of the single most powerful components of the software, 
The Master Database. You will learn how this database interacts with your Client File to reduce 
repetition and maintain consistency for summaries and reports. 

 

4.1 WHAT IS THE MASTER DATABASE? 
The Master database is common for ALL client files. Its purpose is to: 

¶ Save time by not having to retype product and other input names  

¶ Maintain default prices, yields and usage rates  

¶ Allow users to configure drop-down lists to their own specifications  

¶ Standardise terms and groupings for use in Reports, Summaries and History (Quality 

Assurance) 

The Master Database can be opened from the Tools Menu or tool button      

 

 

Prices in the Master Database are default only, and can be overwritten at any stage in the client file. 

Changes to the Master Database ARE NOT automatically reflected in Client files, though can be 

manually updated per year by using Tools > Update client from master. 
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When entering names, bear in mind that this is how they will appear in summaries and reports. Note 

also that the drop-down lists in the client files will sort these by alphabetical order and so the 

naming convention should facilitate the fast find feature of pressing the first letter of an input. 

The Master database is structured to allow you to Add, Modify or Exclude items under the headings 

ς Crops/Fertilisers/Chemicals/Operations/Timings/Production/Livestock and General. 

Images as bmp files can be added in the Timings section and show in the Spray Program Report. 

Utilise the + and ς buttons to collapse the branch and expose the contents under each heading i.e. 

Crops ς Broadleaf/Fallow etc 

 You can utilise the EXCLUDE tick box (tick to exclude) to remove certain 

items from your drop down selections in PA that you do not wish to see. 

i.e. controls what appears in lists - certain Fertiliser suppliers or blends etc. 

Values are copied from the Master Database to Client Files when using Drop-List. These values then 

become part of the Client File and will remain as such until they are either overwritten or reselected 

from Drop-List. Using the Update From Master Command on the Tools Menu of the Main Program 

can refresh updated details in the Master.  

The Master database ŦƛƭŜ ά!ŘǾƛǎŜǊaŀǎǘŜǊΦǇƳέ ƛǎ ƛƴǘŜǊŎƘŀƴƎŜŀōƭŜ ǿƛǘƘ ƻǘƘŜǊ ǳǎŜǊǎΦ .ȅ ŘŜŦŀǳƭǘ this file 

is located under your \Back Paddock Software\Adviser\aŀǎǘŜǊ 5ŀǘŀ ŘƛǊŜŎǘƻǊȅ ƭƻŎŀǘŜŘ ƛƴ ȅƻǳǊ άaȅ 

5ƻŎǳƳŜƴǘǎέΦ 

To share your Master Database with another user you are required to Export your database as a 

*.pm file by selecting File/Export Master As, selecting a directory where you wish to Save your 

database file and then giving the File a name in the File Name box. Select SAVE to create the file in 

the selected directory. 

When you have sent your database to another user of Adviser/Manager, they need to Save the file 

ǘƻ ǘƘŜƛǊ ŘƛǊŜŎǘƻǊȅ ƻŦ ŎƘƻƛŎŜ ŀƴŘ ǘƘŜƴ άhǇŜƴέ ǘƘŜƛǊ ŜȄƛǎǘƛƴƎ aŀǎǘŜǊ 5ŀǘŀōŀǎŜΦ 

To utilise your master database on their copy of Adviser/Manager they need to select File/Set 

Master File and then use the BROWSE option to select the appropriate directory where they saved 

your master database copy with a *.pm extension. When found, select the File name by clicking on it 

ǘƻ ƘƛƎƘƭƛƎƘǘ ŀƴŘ ǘƘŜƴ ǎŜƭŜŎǘ άht9bέΦ ¸ƻǳǊ ŘŀǘŀōŀǎŜ ǿƛƭƭ ƴƻǿ ōŜ ǘƘŜ ŘŜŦŀǳƭǘ ŘŀǘŀōŀǎŜ ŦƻǊ ǘƘŜƛǊ Ŏƻpy 

of PA. To revert to your original database simply select the RESTORE DEFAULT option on the same 

page. 
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: 

Exercise 4.1 
Adding and Deleting Master Database 
items  
 

Adding a new item 

1. άhǇŜƴέ ǘƘŜ ƳŀǎǘŜǊ ŘŀǘŀōŀǎŜ 

2. Select Herbicide in the Navigation tree. 

3. In the sub groups within Herbicide select Group-M Glycine 

4. Select the add button. A new row will appear at the base of the group M Table in the 

right pane. 

5. !ŘŘ ŀ ƴŜǿ ǇǊƻŘǳŎǘ ŎŀƭƭŜŘ άƴƻ ŦǊƛƭƭǎ ƪƛƭƭέ ƘŜǊōƛŎƛŘŜ όƎŜƴŜǊƛŎ DƭȅǇƘƻǎŀǘŜ прлύ ŀƴŘ ǘȅǇŜ ƛƴ 

the details. 

6. You may wish to sort at this stage as the order in this table persists in the drop downs 

in the main program. To do this, select the sort button from the toolbar. 

Deleting an Item 

1. Deleting a product is very similar to adding, lets delete the product we just added; 

2. {ŜƭŜŎǘ ǘƘŜ ǇǊƻŘǳŎǘ ǘƻ ŘŜƭŜǘŜ άƴƻ ŦǊƛƭƭǎ ƪƛƭƭέ ƘŜǊōƛŎƛŘŜ όƎŜƴŜǊƛŎ DƭȅǇƘƻǎŀǘŜ прлύ 

Chemicals-Herbicide-M Glycine- then the product 

3. {ŜƭŜŎǘ ǘƘŜ ŘŜƭŜǘŜ ōǳǘǘƻƴ ƻƴ ǘƘŜ ǘƻǇ ǘƻƻƭōŀǊ ǘƘŜƴ άȅŜǎέ ŦǊƻƳ ǘƘŜ ŘǊƻǇ ŘƻǿƴΦ bƻǿ 

minimise the herbicide section by selecting the minus button adjacent to herbicide. 

Excluding an Item 

1. Excluding items is just as easy by ticking the box adjacent to the item to be excluded; 

2. Select the item to be excluded then tick the box. Select fertilisers then tick the supplier 

companies that you do not deal with 

3. Select another item that you may never use and exclude it, select operations then tick 

a product. 

modifying an Item 

1. Modifying an item is just a matter of typing over the existing figures. Commonly rates 

per hectare, costs and expected yields and returns are areas that need to be checked. 

2. Select crops Broadleaf (Dicot) and change the yield and $/T value figures for canola. 

3. Select Chemicals-Herbicides-Achieve WG and change the cost and default application 

rate to $90 and .38. (380 grms)   

 

You can also PRINT your selections for Crops/Fertilisers/Chemicals and Operations by utilising the 

PRINT LISTS option, and if need be control this list via the EXCLUDE option within each sub heading 

group 
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Chapter 5 ς Data Entry 
 

Lƴ Ψ/ƘŀǇǘŜǊ о ς bŀǾƛƎŀǘƛƻƴΩΣ ǘƘŜ ŎƻƴŎŜǇǘ ƻŦ ǘƘŜ aŀƴŀƎŜƳŜƴǘ Zone was introduced and was 
defined as a particular piece of land over a given timeframe. At this point we should revisit 
the Management Zone as it is at the core of all our input data entry. 

 

COMMON METHODS FOR ENTERING DATA 
Throughout the software the process for adding, editing or deleting records is consistent. The 

common buttons are as follows: 

 Add new record to bottom of table 

 

 Delete selected record 

 

 Shift record up one row (change sort order) 

 

 Shift record Down one row (change sort order) 

 

Copy plans to actuals 

   

 

 

Note that deleting a record is permanent with no undo function,  

however you are always prompted to prevent accidental data loss. 

 

 
 
 
 
 
 
 
 
 
 

There is an up to date master data base file available on the back 
paddock website www.backpaddock.com.au  or by request via the help 
desk on 1800 557 166 7am -7pm EST or email 
support@backpaddock.com.au  

 

 

 

 

http://www.backpaddock.com.au/
mailto:support@backpaddock.com.au
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 Table Layout ς Management Zone Table 
(Management Tab) 

 
Crop Type  Crop Type name from Master List 
Variety O Variety name from Master List 
$/T  Seed price in dollars per tonne 
Ha  Seeding area of this Management Zone 
Kg/ha  Seeding rate in kilos per ha 
Date O Seeding Date 
Pasture O Indicates pasture (necessary to allocate livestock paddocks) 
U/Sow O Indicates zone is under sown 
Blend O Indicates blended seed 
Grade O Indicates graded seed 
Irrigated O Indicates zone is irrigated 
Summer O Zone is a Summer crop 
Symbol O Footnote symbol used in reports 
Footnote O Notes for Zone. Also used as zone footnote in reports 

O = optional   

5.1 MANAGEMENT SECTION 
 

 

 

By default each paddock has a Management Zone defined for each year. This simplifies the data 

entry process considerably unless we wish to split a paddock into two or more Management Zones. 

As the Management Zone is usually defined by its crop type or rotation status it follows that this is 

the best place to start entering data. 

The crop type can be set either on the Management View or the Rotations View.  The Rotations 

section can be a good place to plan the whole-farm cropping program in one place without the 

distraction of inputs other than seed (Refer to Rotations section). 

MANAGEMENT ZONE DATA 
 

 

Primarily the data entered in the Management Zone table is the crop type and seeding rate 

information. Available data fields are summarised below.  
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In addition to these fields, buttons on the Management Zone toolbar provide access to other tables 

for data linked to the currently selected zone. 

BLEND 

Opens the seed blend dialog - This allows any number of seed varieties to be used on one zone. 

DRESS 

Opens the seed dressing dialog - This is used to apply any product to seed at a constant rate per 100 

kg of seed. Examples are seed fungicides, inoculants etc. Currently inoculant rates are calculated on 

the sowing rate of the main crop grown and not the undersown pasture, so in this situation enter 

the amount of inoculant required for the pasture seed per paddock 

PRODUCTION 

Opens the production dialog - Here you can enter grain production for the zone. Production can be 

entered in any number of loads and quality / price information recorded.  

IRRIGATION 

Opens the seed irrigation dialog - This section allows water costs and volumes to be attributed to 

zone. (This section currently under renovation/enhancement) 

FLAGS 

Selecting the flags tab exposes the check box flags that consist of pasture, u/sow, Blend, Grade, 

Irrigated, Summer, Hort. and Perm. Check the corresponding boxes to the relation of the paddock. 

When checking the Horticultural and Permanent boxes, new options then become available to edit 

data in.  

 

 

Share Farming  

/ƭƛŎƪƛƴƎ ƻƴ ǘƘŜ ǎƘŀǊŜ ŦŀǊƳƛƴƎ ǘŀō ōǊƛƴƎǎ ǳǇ ǘƘŜ Ψ{ƘŀǊŜ CŀǊƳƛƴƎΩ ǿƛƴŘƻǿ ǿƘŜǊŜ ŜŀŎƘ ǇŀŘŘƻŎƪ Ŏŀƴ ōŜ 

designated Share farming status. In this window you are able to adjust the percentage of income and 

costs that are attributed to the particular share farmer. Clicking on the Edit Share Farmers tab allows 

you to enter key associated notes about the particular share farmers. When a paddock has been 

designated as a share farm, then a symbol will appear in the navigational tree to indicate that the 

particular paddock is shared.  
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The share farming cost splitup can also be changed in the fertiliser and operations sections of each 

paddock although it defaults to the figures selected in the client options area if changes are not 

made. 

Note: To enable farm sharing you must first apply it in File>Client options 

PADDOCK NOTES 

The show paddock note from farm section is an important function as it displays the notes from the 

farm section in the management section and also in the report. It is useful in remembering key 

issues or points of interest within the selected paddock. The notes are displayed above the paddock 

name in the management tab and are displayed under the crop/variety section in the report for each 

paddock. 

Other functions on the Management Zone toolbar 

 

 

 Exposes paddock linking field in Management Zone table 

 Opens coverage map editor for zone (not included in Lite versions) 

 Displays paddock note from Farm View at top of Management Zone table 

 Opens Share Farming dialog 
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5.2 DATA TABS 
 

 

 

The data panes consist of 10 different sections that range from fertilisers to the rotation analyser. In 

these panes certain management adjustments and decisions can be made. 

Fertiliser 

 

 

 

Each of the following tabs in the fertiliser pane are shown below: 

 

 Moves Selected 

 Add  

 Remove / Delete 

 Copies plan data to actuals 

 Opens coverage map editor for application (not included in Lite versions) 

 Opens fertiliser history / nutrient audit dialog 

 Opens soil/plant tests dialog 

 Exposes fields in Fertiliser table that contain elemental analysis for fertiliser product 

 

Primarily the data entered in the Management Zone table is the crop type and seeding rate 

information. Available data fields are summarised below.  
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F 
Take care when 
applying liquid 
fertilisers. Be sure 
that the price is $/T 
and the analysis is by 
volume. If the bulk 
density is not 
included for liquids 
then the summary 
totals may be wrong. 

 

 

 

 Table Layout ς Fertiliser Table (Management Tab) 

 

Fertiliser  Fertilise name from Master List 

Cost ($/T)  Fertiliser cost in dollars per tonne 

Area  Fertiliser spreading area in ha 

Kg or l/ha  Application rate in tones per ha 

Elements × 12  Elemental analysis in % 

Timing O Timing description from Master List 

Date O Application date 

Liquid  Indicates the fertiliser is a liquid 

BD (t/m
3
)  If liquid then a Bulk Density is required here 

Share % O Percent cost contributed by share farmer 

Symbol O Footnote symbol used in reports 

Footnote O Notes for application. Also used as footnote in reports 

    O = optional  

 

Fertiliser History 

The fertiliser history section derives information from actual data rather than plan data. Once a 

ŦŜǊǘƛƭƛǎŜǊ Ƙŀǎ ōŜŜƴ ŎƻƳǇƛƭŜŘ ƛƴ ǘƘŜ Ǉƭŀƴ ǎŜŎǘƛƻƴΣ ŎƭƛŎƪƛƴƎ ƻƴ ǘƘŜ ΨŀŎǘǳŀƭΩ ōǳǘǘƻƴΣ ǿƛƭƭ ŎƻǇȅ ǘƘŜ Řŀǘŀ 

from the plan section to the actual section.  

*  ²ƛǘƘƻǳǘ ǘƘŜ Řŀǘŀ ƛƴ ǘƘŜ Ψ!ŎǘǳŀƭΩ ǎŜŎǘƛƻƴ ǘƘŜ ǇǊŜǾƛƻǳǎ ȅŜŀǊΩǎ ŦŜǊǘƛƭƛǎŜǊ ǊŜŎƻǊŘǎ ǿƛƭƭ ƴƻǘ ōŜ ŘƛǎǇƭŀȅŜŘ 

when the fertiliser history window is displayed. 

The Fertiliser history button displays a new window that displays the paddocks fertiliser history over 

a selected period of time. To determine the number of years that are displayed for the paddock 

ƘƛǎǘƻǊȅΣ ǎŜƭŜŎǘ ǘƘŜ ǎŎǊƻƭƭ Řƻǿƴ ƳŜƴǳ ƛƴ ǘƘŜ ȅŜŀǊΩǎ ǎŜŎǘƛƻƴΦ CǊƻƳ ƘŜǊŜ ȅƻǳ Ŏŀƴ ŘŜǘŜǊƳƛƴŜ Ƙƻǿ Ƴŀƴȅ 

years back you want to view the paddocks fertiliser history. 
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: 

Exercise  
Adding Fertiliser  
 

 

LetΩǎ ŀŘŘ ŦŜǊǘƛƭƛǎŜǊ ǘƻ ȅƻǳǊ ǇŀŘŘƻŎƪǎΦ ¸ƻǳǊ ŎƭƛŜƴǘ ŦƛƭŜ ƴŜŜŘǎ ǘƻ ōŜ άhǇŜƴέ ŀƴŘ ǎŜƭŜŎǘ 

ǘƘŜ ΨƳŀƴŀƎŜƳŜƴǘΩ ǘŀōΤ 

 

1. Select a paddock, click on the fertiliser tab then press the Add Record button for 

the Fertiliser table, and select a fertiliser from the Drop down arrow in the 

fertiliser column. Add a granular fertiliser such as DAP to be applied by a drill at 

seeding. Fertilisers can also be deleted in this manner using the delete button . 

Fertiliser can be sorted by using the up/down toggles located at the top left of 

each table. This sort order will be used in reports. 

2. Click on and complete the other cells to the right including cost, application rate, 

timing and sowing date. 

3. If you ƴƻǿ ǎŜƭŜŎǘ ǘƘŜ Ψ9ƭŜƳŜƴǘǎέ ōǳǘǘƻƴ ŀōƻǾŜ ƛǘ ǿƛƭƭ ŘƛǎǇƭŀȅ Ƨǳǎǘ ŜȄŀŎǘƭȅ ǿƘŀǘ 

elements are being applied. 

4. Lets presume you need more nitrogen, again select the Add Record button  and 

select urea. Applied this product at 50kg/ha at growth stage 39 on 1/09/2006 by 

air. It is the same procedure if you were to add a fluid fertiliser, the only difference 

being you need to tick the liquid fertilise box so that the bulk density of the 

product is taken into account when analysing applied elements. 

5.  Fertilisers can also be deleted in this manner using the delete button . Fertiliser 

can be sorted by using the up/down toggles located at the top left of each table. 

This sort order will be used in reports. 

6. Fertiliser history and a nutrient audit can be viewed by selecting the history 

button. 

 

 

Once the number of years are determined the years will displayed in the left hand side column. The 

other columns consist of the crop grown in that particular year, the fertiliser applied during the year, 

the area applied, kg or l/ha, the date and the nutrients by kg/ha. To display the nutrient audit, simply 

check the box at the top of the screen. This will then display extra rows within the year 

that determine the removed nutrients per T/ha. To print the fertiliser history simply click on the 

print button located at the top left hand of the screen. 
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SPRAYS 

 

The spray pane contains three different sections that consist of the spray manager, mix and 

chemicals. 

Spray Manager 

The spray manager section allows you to adjust whether or not you want to view the chemical or 

adjuvant on the corresponding screen. This can simply be done by checking and un-checking the 

desired box.  

 

 

 

¢ƘŜǊŜ ŀǊŜ ǘƻ ǾƛŜǿ ƳƻŘŜǎ ǘƻ ŎƘƻƻǎŜ ŦǊƻƳ ƛƴ ǘƘŜ ǎǇǊŀȅ ƳŀƴƎŜǊ ǎŜŎǘƛƻƴ ǘƘŀǘ Ŏƻƴǎƛǎǘǎ ƻŦ ǘƘŜ ΨŜŘƛǘ ǾƛŜǿΩ 

and thŜ ΨǎǳƳƳŀǊȅ ǾƛŜǿΩΦ  

 

Each of these views are as their name suggests with the edit view enabling you to edit the sprays 

and the summary view providing you with an overall spray summary for the paddock. 

Whilst in the summary view you are also able to choose the specific details you want to display by 

checking or un-checking the boxes. Once you have your desired display you have the option to print 

the sheet by selecting the print button 

. 
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Sprays Mix 
 

Functions on the Sprays Mix toolbar 
 
 

 
 

    Move the selected mix up or down 
 

    Create a new mix 
 

    Delete the current Mix   
  

    Coverage Map 
 

    Show the spraying history 
 

    Copy Plans to Actual 
 

  Adjust the default water rate 
 

    Show/Hide Sprayed Area (defaults to 100%) 
 

   Concentrated Spray 
 

The default water rate can be adjusted to apply to each new mix by simply entering a new water 

rate figure in the provided section.  

 

The mix section determines the required water mix with the chemical/s for the particular paddock 

that is being sprayed.  

 

By ticking the Conc. Spray box, you are adjusting the spraying method to a concentrated spray, as 

used in horticulture, rather than a broad acre spraying method.  

 

A new column then appears which allows for the runoff rates to be calculated and included in to the 

spraying calculation.  
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 Table Layout ςMix Table (Sprays Tab) 

 

Mix  Displays the numbered mix 

Ha  The area to be sprayed 

Water L/ha  Water rate (default rate can be changed above) 

Water Req. L  Calculated water required 

Target Species o Lists the Targeted Species for the Chemical 

Timing  o Crop stage 

Date o Spraying date 

Notes o Additional notes 

Runoff L/ha O (Active when Conc. Spraying checked) 

    O = optional  

 

Chemicals/Adjuvants 

The chemical/Adjuvants section allows you to choose the particular chemical that is to be used on 

the particular paddock. This is done by simply clicking on the scroll down arrow (1) in the chemical 

space and choosing from the list the particular chemical desired (2). 

 

 

 

 

 

 

 

 

 

 

Chemical History 

The chemical history operates in the same respect as the fertiliser history. The same steps are 

required in order to display the number of years for the chemical history as in the fertiliser history.  

 

ϝ5ŀǘŀ Ƴǳǎǘ ōŜ ΨŀŎǘǳŀƭΩ Řŀǘŀ ŀƴŘ ƴƻǘ ΨǇƭŀƴΩ Řŀǘŀ ǘƻ ǾƛŜǿ ŎƘŜƳƛŎŀƭ ƘƛǎǘƻǊȅ 

The columns display the year, crop of the particular year, chemical class, group, type, chemical brand 

name, units, units/ha, area, date and the timing. 
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Exercise  
Adding Chemicals  
 

 

Lets add chemicals to your paddocks. Your client filŜ ƴŜŜŘǎ ǘƻ ōŜ άhǇŜƴέ ŀƴŘ ǎŜƭŜŎǘ 

ǘƘŜ ΨƳŀƴŀƎŜƳŜƴǘΩ ǘŀōΤ 

 

1. {ŜƭŜŎǘ ŀ ǇŀŘŘƻŎƪΣ ŎƭƛŎƪ ƻƴ ǘƘŜ ǎǇǊŀȅǎ ǘŀō ǘƘŜƴ ǇǊŜǎǎ ǘƘŜ !ŘŘ ΨƴŜǿ ƳƛȄΩ ōǳǘǘƻƴ ŦƻǊ ǘƘŜ 

mix table, and select the specific water levels required, target species, timing, date 

and add any particular notes in relation to the chemical and paddock. To change the 

default water rate simply enter in the top of the pane. The mixes can also be deleted 

in this manner using the delete button . Mixes can be sorted by using the 

up/down toggles located at the top left of each table. This sort order will be used 

in reports. 

 

2. Once the mix is complied, it is time to add the chemicals to the mix. This is done in 

the chemical pane below the mix pane. 

 

3. /ƭƛŎƪ ƻƴ ǘƘŜ ΨŀŘŘ ŎƘŜƳƛŎŀƭΩ ōǳǘǘƻƴ ŀƴŘ ǘƘŜƴ ŎƭƛŎƪ ƻƴ ǘƘŜ ǎŎǊƻƭƭ Řƻǿƴ ƳŜƴu in the 

chemical column to choose a particular chemical.  

 

4. To add an adjuvant to the mix, click on the adjuvant tab located at the bottom of the 

screen. The same steps are then repeated as when adding a new chemical to the 

mix. 

 

5. Chemicals and Adjuvants can be deleted using the delete button . Chemicals and 

Adjuvants can be sorted by using the up/down toggles located at the top left of 

each table. This sort order will be used in reports. 

 

6. Chemical history can be seen in the history button located at the top of the pane. 

 

7. To view a summary of the particular chemicals being applied to the paddock, click 

on the summary tab in the view window to the left hand side of the chemicals pane.   

 

 

To print the chemical history simply click on the print button located at the top left of the window. 
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 Table Layout ςOperations 
 

Operation   Choose the type of operation 

Details  Details you may wish to enter about the operation 

Area  The selected area 

Cost ($)  Calculated cost 

Timing o Stage of operation 

Date o Date of Operation 

Link type o Linked Activity to Operation 

Link Item  Linked items 

Share  Share percentage 

Symbol  Additional symbols 

Footnote  Additional footnotes to record 

    O = optional  

OPERATIONS 

The operations pane allows you to input the particular operations that will occur within the paddock 

at a particular point in time. In this section you are able to link particular operations to other 

activities. 

 

¢ƻ ƛƴǎŜǊǘ ŀ ƴŜǿ ƻǇŜǊŀǘƛƻƴ ƛƴǘƻ ǘƘŜ ǇǊƻƎǊŀƳΣ ŎƭƛŎƪ ƻƴ ǘƘŜ ΨƛƴǎŜǊǘ ƴŜǿ ƻǇŜǊŀǘƛƻƴ ōǳǘǘƻƴΩ ŀƴŘ ŎƭƛŎƪ ƻƴ 

the scroll down menu in the operations column. 

Select a particular operation and the area and cost will appear automatically in the other columns 

deriving the information from the master database. Then select the appropriate timing, symbol and 

any other notes that can be included for the particular operation.   

Linking Operations 

To link a particular operation to a particular link type, simply click on the linking button at the top of 

the pane to display the linking column.    

With the linking column displayed, you are then able to select a particular link to the operation by 

ǳǎƛƴƎ ǘƘŜ ǎŎǊƻƭƭ Řƻǿƴ ƳŜƴǳ ƛƴ ǘƘŜ Ψƭƛƴƪ ǘȅǇŜΩ ŎƻƭǳƳƴΦ  
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!ƭǎƻ ǘƘŜ Ψ[ƛƴƪ ƛǘŜƳΩ ǎŜŎǘƛƻƴ ŀǇǇŜŀǊǎ ǿƘƛŎƘ ŀŘŘǎ ǘƘŜ ƻǇǘƛƻƴ ǘƻ ƛƴŎƭǳŘŜ ǘƘŜ Ǉƻǎǎƛōƛƭƛǘȅ ƻŦ ŘƛŦŦŜǊŜƴǘ 

harvest units. This option is Not defaulted to grain so must be selected in certain circumstances  

 

To unlink the operation simply click on the link button again  

! ŎƻƳƳƻƴ ƭƛƴƪ ǘȅǇŜ ƛǎ άIŀǊǾŜǎǘ όϷκ¦ƴƛǘύέ ǿƘŜƴ ƭƛƴƪƛƴƎ ŀ ƎǊŀƛƴ ŎŀǊǘŀƎŜ Ŏƻǎǘ ǘƻ ŀ ȅƛŜƭŘ ǎŀȅ ŎŀǊǘŀƎŜ ƻŦ 

Ϸнлκ¢Φ Lƴ ǘƘƛǎ ǎƛǘǳŀǘƛƻƴ ǘƘŜ ƭƛƴƪ ƛǘŜƳ ƻŦ άDǊŀƛƴέ Ƴǳǎǘ ŀƭǎƻ ōe selected. 

Importance of Operations 

It is important that the data entered in the operations section is accurate. All the data collected in 

the operations section is summarised and calculated in the gross margins section. Therefore it is 

important that the operation data is correct in terms of costs.  

The operations are also displayed in the cash flow, so it is important that the correct dates and 

figures are entered into the operations section so that they are displayed in the correct month in the 

cash flow projection table in the Adviser and Manager programs.  

SUMMARY 

 

The summary pane displays the summary of the operations and adjustments previously made in 

each individual paddock. It shows the cost, area and quantity of the particular variables over the 

ȅŜŀǊΦ 9ŀŎƘ ƻŦ ǘƘŜ ǇŀǊǘƛŎǳƭŀǊ ǎǳƳƳŀǊȅ ŘǊƻǇǎ Řƻǿƴ ƳŜƴǳΩǎ Ŏŀƴ ōŜ ǎŜŜƴ ōŜƭƻǿΦ 

 

 

 

 

 

 

 

 

 

This particular menu determines the variables that will be displayed in the 

summary display. These variables consist of Crop, variety, fertilizer, 

chemicals, and operations.  

 

This particular menu determines the cost, quantity or area of the particular 

variable at a particular time. 

This menu determines what portion of the season will be displayed in the 

summary.  
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¢ƻ ŘƛǎǇƭŀȅ ǘƘŜ ǎǳƳƳŀǊȅ ƻǾŜǊ ŀ ƳƻƴǘƘƭȅ ǇŜǊƛƻŘΣ ǎƛƳǇƭȅ ŎƘŜŎƪ ǘƘŜ ōƻȄ ǘƘŀǘ ǎǘŀǘŜǎ ΨǎƘƻǿ ƳƻƴǘƘǎΩ  

 

The summary displayed can also be printed by simply clicking on the print button  

DIARY 

 

The diary pane allows for you to enter notes or data for particular dates in regards to the selected 

paddock. It also allows for you to enter rainfall figures in for each day of the year. 

There are three months displayed on the screen and can be scrolled through by pressing the arrow 

keys located next to the two months on the edges.  

 

To enter a specific diary entry on a particular date, simply click on the date on the calendar and then 

press the add note button which will then bring up a section to write a particular entry. 

 

To gain an overall summary of all the paddocks on the farm, click on the Farm Name or Block name 

in the navigation ǇŀƴŜ ŀƴŘ ǘƘŜƴ ŎƘŜŎƪ ǘƘŜ ōƻȄ Ψ{ǳƳƳŀǊȅ aƻŘŜΩ Φ  

This should bring up all of the notes and data over a period of time for each of the paddocks in the 

section below. To change the particular time frame of the Summary mode, click on the starting date 

ŀƴŘ ǘƘŜƴ ŎƭƛŎƪ ƻƴ ǘƘŜ ΨCǊƻƳΩ tab.   

This should change the date to the particular date currently selected on the calendar. Repeat the 

same steps as above to get the end date by selecting the end of the time frame on the calendar and 

ǘƘŜƴ ǇǊŜǎǎƛƴƎ ǘƘŜ Ψ¢ƻΩ ǘŀōΦ  

To obtain a printed version of the summary, simply click on the print button located above the 

notes.  
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 Table Layout ς Production (Price/Yields) 

 

Units  Select Unit type i.e.  onne sect  

Kg/Units  Determine the number of Kg per Unit 

Target Grade o The target grade for the current crop selected 

Pessimistic Price ($/t)  Estimated Price at a Pessimistic view  

Expected Price ($/t)  Expected price to receive  

High Price ($/t)  Estimated Price at a optimistic view  

Pessimistic yield (T/ha)  Estimated Yield at a Pessimistic view  

Expected yield (T/ha)  Expected Yield to receive  

High yield (T/ha)  Estimated Yield at a optimistic view 

Retain (T) o Amount of seed to retain from paddock 

Estimated Harvest Date o Estimated date of harvesting the particular paddock 

    O = optional   

PRODUCTION 

 

The production pane determines the expected prices and yields for the particular paddock 

highlighted in the navigation section. To view other paddocks prices and yields, scroll through the 

paddocks in the navigation pane. In this section you able to add additional harvest units like Wheat 

grain and straw ect. The default settings are set to grain but can be adjusted by selecting the 

products link or adding another production unit. 

 

At the bottom of the pane there is crop production forecast that includes the crop, variety and 

Grade. This displays the crop production forecast in tonnes by the three different perspectives, 

which include pessimistic, expected and high.  

 

The crop production forecast can be summarised by crop, variety and grade by selecting the various 

displays.  
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 Table Layout ς General 
 

Opening Balance ($) 0 Opening Balance of the year 

Working Account Interest Rate (%) 0 Current financial interest rates 

Estimated months in debt 0 Months in debt estimate 

Quick budget Chemical costs ($/ha)  Quick overall Chemical costs budget 

    O = optional  

GROSS MARGINS 

 

The gross margins pane shows the gross margins of each individual paddock or over the whole farm 

depending on which is currently selected in the navigations pane. 

DǊƻǎǎ ƳŀǊƎƛƴǎ Ŏŀƴ ōŜ ǾƛŜǿŜŘ ƛƴ άtƭŀƴέ ƻǊ ά!Ŏǘǳŀƭέ ƳƻŘŜǎΦ ²ƘŜƴ ǘƘŜǊŜ ŀǊŜ Ŏƻǎǘǎ ŀǎǎƻŎƛŀǘŜŘ ǿƛǘƘ ŀ 

ǇŀǎǘǳǊŜκƎǊŀȊƛƴƎ ǇŀŘŘƻŎƪ ƛǘǎ ōŜǎǘ ǘƻ ǎŜƭŜŎǘ άtŀǎǘǳǊŜ aŀƛƴǘŀƛƴŜƴŎŜέ ƛƴ ǘƘŜ ǇǊƻŘǳŎǘƛƻƴ ǘŀō ǘƻ ŜȄǇƭŀƛƴ 

the negative gross margin. In this situation income can be assigned to the livestock section. To 

include the depreciation and interest accumulated, simply check the corresponding boxes at the top 

of the pane. 

By checking the boxes for both the interest and depreciation, the accumulated interest and 

depreciation for the year are displayed in the gross margin. These contribute to the costs of the farm 

but are generally absent from the gross margins as they are commonly fixed costs.  

To Print the gross margins, simply click on the print button located at the top left of the pane. 

GENERAL 

 

In the General Pane financial data is recorded so it can be incorporated within the program and the 

report. There is also space available at the bottom of the pane to add additional notes for general 

comments on the particular year. These notes display at the start of the report. 
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WATER USE EFFICIENCY 

 

The water use efficiency pane calculates the total net water use efficiency of the particular paddock 

highlighted in the navigation pane by using the French & Shultz equation.  

The first step in this section is to set the water use efficiency crop parameters by clicking on the 

button in the top left of the pane. 

This will bring up an additional window where the crop parameters can be entered for reference in 

the calculation. 

A typical crop parameter layout can be seen in the following table below. The crop parameters are 

composed of the crops non-productive water (NPW) that consists of mm lost to evaporation, 

leaching, run-off etc during a normal year and a dry year. The harvest index represents the total 

percentage of the crop biomass extracted at harvest and the root index represents the total 

percentage of crop roots compared to entire crop. 

  

After the data has been recorded, return the main screen by pressing ok. At the main screen the 

Starting available Soil Moisture (SASM) and the Harvest available soil Moisture (HASM) can be 

entered in the blue figures. Entering the figures in the top sections can also set the default level.  
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Once these figures have been entered into the corresponding places, then the calculations are 

compiled and displayed below using the French & Shultz Equation. To distinguish the differences 

between dry conditions and normal conditions simply click on the scroll down menu above and 

select the appropriate one.  

 

*The total rainfall figures are calculated from the input of rain data into the rainfall section at the 

top 

 

ROTATION ANALYSER   

 

 

The Rotation analyser provides a range of analysis that is dependent on the type of rotation that has 

been established over the years on a particular paddock. The rotation analyser can display the 

rotations for a 3 to 10 year time period, which can be adjusted at the top of the pane. 

 

The default tillage, burn and removal factors can also be changed at the top of the pane by entering 

the figures in the spaces available. 

 

 

The Concept of Sustainability 

Sustainability is the goal of most modern businesses and it is increasing a much talked about 

concept. Sustainable agriculture is generally quoted to integrate three main goals - environmental 

health, economic profitability, and social and economic equity (Feenstra et al. 1997). Measurement, 

management and manipulation of sustainability has been an elusive concept for the farm 

practitioner due to the often-large number and complexity of the measurements required to 

produce a result from the more academic sustainability indices.  
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The Rotational Analyser  

The Rotation Analyser approach to sustainability management is proposed based on the premise 

that at the most simplistic level: sustainability of farming is a function of efficiency of use of the most 

limiting resource (generally water), soil health (a function of carbon input) and profitability (gross 

margin). Rotation Analyser requires input of a small number of commonly available paddock details 

such as total crop rainfall, crop yield and value, and variable costs. These inputs are used to calculate 

ratios such as:  

¶ Precipitation Use Efficiency ς efficiency of conversion of rainfall into produce ς using fallow 

plus in-crop rainfall received adjusts this ratio for the effectiveness of the enterprise owner 

in storing and extracting soil water. Decisions about tillage, weed control, nutrient use, 

sowing date etc all impact on this ratio. 

¶ Carbon Conversion Efficiency ς efficiency of conversion of water into plant carbon to sustain 

soil health 

¶ $ Precipitation Use Efficiency ς how effectively rainfall is turned into dollars 

¶ Carbon Efficiency Index ς Greenhouse gas is an issue that is starting to impact on the farm 

sector. This ratio is derived from the soil carbon inputs and variable cost reflects the carbon 

returned to the soil per unit if carton consumed, using the assumption that most of the 

variable cost inputs are high carbon emitting during their production eg fertiliser and fuel. 

¶ Input Cost Efficiency ς effectiveness of using variable cost (energy) inputs. 

¶ Economic Efficiency ς efficiency with which economic resources (variable costs) are used. 

These ratios are then used to calculate and overall sustainability index to allow the comparison 

between rotation plan for a paddock or between paddocks. They also play a vital role in providing 

information about the strengths and weaknesses of individual crops in the rotation allowing 

tradeoffs between areas such as profit and soil health to be made with some knowledge about the 

scale and impact on the overall sustainability of the rotation.  
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Spray Recommendations 

The Recommendations tab is located in the Management Tab. Recommendations are "stand alone" 
and not linked directly to plan or actuals.  Once created and saved the paddock recommendation can 
be copied and ǎŀǾŜŘ ŀǎ ŀƴ ά!Ŏǘǳŀƭ wŜŎƻǊŘέ ŀƎŀƛƴǎǘ ǘƘŜ ǇŀŘŘƻŎƪόǎύ ƛƴ ǘƘŀǘ ȅŜŀǊΦ 

A recommendation report can include; 

¶ Single or multiple spray recommendations 

¶ Each recommendation can include any number of paddocks 
 

 

 
 
 
 
 

1. To Create a new Spray Recommendation click the   button.  A new 
Recommendation will be now be available in the Recommendation History panel. 
 
 

2. To Edit a Spray Recommendation click the   button.  This will open the Spray 
Recommendation Manager panel. 

             *When editing a Spray Reccomendation please note that it will be saved to the paddocks                                                                                                                 
added to the recommendation and not the paddock selected when created.  

 
 

3. To Delete a Spray Recommendation click the   button. 
 
 

4.  To Copy  from Plan to Actuals click the   button 
 
5. Enter a product name into the Filter by Product search box to locate the Spray 

Recommendation containing the product.  (Use this feature to quickly sort through multiple 
Recommendations and group them by product). 
 

 
 
 
 
 
 
 
 
 

 

 
 
























































































































































































